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License Agreement

Vision�s Edge, Inc. provides the computer software program and User Manual contained in the
package (the �Program�), and licenses its use on the terms stated below:

a. You are granted a license to use the Program under the terms stated in this Agreement for
personal use in your business or profession. Title and ownership of the program remains with
Vision�s Edge, Inc.;

b. The Program may be used by you on a computer or computers which you own or use for
which the Program is designed to operate, except that the Program may be used only on one
computer at any one time;

c. You may not make copies, translations or modifications of or to the Program, except you may
copy the Program into machine-readable form for backup purposes in support of your use of
the Program. (Any portion of this Program merged into or used in conjunction with another
program will continue to be the property of Vision�s Edge, Inc. and subject to the terms and
conditions of this agreement.);

d. You may not assign, sell, distribute, lease, rent or transfer the Program or this license to any
other person;

e. This license terminates if you fail to comply with any provision of this Agreement. You agree
upon termination to destroy the Program, together with all copies, modifications and merged
portions in any form.

Macintosh� is a registered trademark of Apple Computer, Inc.   

Disclaimer

Quark, Inc. makes no warranties, either expressed or implied, regarding the enclosed comput-
er software package, its merchantability, or its fitness for any particular purpose. Quark, Inc. disclaims
all warranties including, but not limited to, the warranties of the distributors, retailers and developers of
the enclosed software.

W ithout limiting the foregoing, in no event shall Quark, Inc. be liable for any special, indirect,
incidental, or consequential damages in any way relating to the use or arising out of the use of the
enclosed software.

Quark, Inc.�s liability shall in no event exceed the total amount of the purchase price/license fee
actually paid for the use of the enclosed software.

Some states do not allow the exclusion of implied warranties and/or the exclusion or limitation
of incidental or consequential damages, so these exclusions and limitations may not apply to particular
developers.
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Introduction

XPreview is an application which reads special resources embedded in QuarkXPress docu-
ments by the QuarkXPress XTension Preview Editor Lite. XPreview displays the vital statistics of the
document, including the page size, number of pages, colors, fonts and imported pictures in the docu-
ment. Additionally, the application allows the user to view thumbnail previews of each page of the doc-
ument. The user may even print the information out or save it as a text file for later reference.

Minimum System Requirements

XPreview is network protected and is fully compatible with floppy, RAM, or hard disks. 
This manual assumes that you are familiar with standard Macintosh procedures such as basic

use of the mouse, clicking, pulling down menus, copying files, and copying disks. If any of these pro-
cedures are new to you, please refer to your Macintosh user�s manual.

Installing XPreview

The XPreview disk that you have purchased contains a file named XPreview. To install
XPreview, drag the file onto the computer�s hard drive. 

The XPreview disk that you have purchased contains the file Preview Editor Lite. To install
Preview Editor Lite, drag the file into the same folder that contains the QuarkXPress application.
IMPORTANT:If Preview Editor 2.0 is already present in the folder, do not install Preview Editor Lite. It
may cause conflicts.

After installing XPreview and Preview Editor Lite, place the original XPreview disk in a safe
place. 
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The XPreview Dialog

XPreview allows the user to view vital information about a QuarkXPress document without
opening the document with the QuarkXPress application. The XPreview dialog displays the document
information in an organized manner.

The XPreview Dialog

Information shown on the XPreview dialog includes:

Size � Displays the page size of the current XPress document. 

Pages � Displays the number of pages included in the current document.

Colors list � Lists the names of the colors used in the current document.

Fontslist � Displays the names of the fonts used in the current document. 

Pictures list � Displays the path of all imported pictures in the current document.

Page thumbnail � A thumbnail depicting a page of the current document. If no preview is available for
the current page, the page thumbnail display area displays a message indicating no preview is
available. 

The �No Preview Available� message
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Page number controls � Left and right arrow buttons allow the user to display the different pages of
the current document in the page thumbnail display area. The page number of the page being
displayed is shown between the left and right arrow buttons. 

Documents popup menu � Allows selection from the documents whose preview information is cur-
rently loaded into the XPreview application. Selecting a document from the lists replaces the
information in the XPreview dialog with the data about the newly selected document.

Opening a Document in XPreview

An XPress document file�s preview data may be opened by the XPreview application one of two
ways. 

� Using the Preview Document dialog
� Dragging a document onto the application

The first method which may be used to open a document�s XPreview data requires that the
XPreview application be already running. To start XPreview, double-click on the XPreview application
icon in the Finder.

The XPreview icon

Once XPreview is active, select Preview Document� from the File menu or enter command-O
from the keyboard. A dialog appears, prompting the user to select the desired document. Once the
document is selected, click the Open button to display that document�s preview data.

The Preview Document dialog

The second way to open a document in XPreview is to drag the document onto the application
in the Finder. To do this, click on the desired document and, holding down the mouse button, drag the
document onto the XPreview application icon until the icon darkens, then release the mouse button. If
the application is not already active, it launches, then the XPreview dialog appears, displaying the infor-
mation about that document in its fields.  
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If the user attempts to open a document in XPreview which has not had any preview resources
attached to it, XPreview displays an alert informing the user that the preview resources were not found. 

An example alert telling the user why XPreview 
can not open the preview information

Opening Multiple Documents in XPreview

Although the XPreview dialog only displays information about one document at a time, the
application can load data about multiple documents into memory to be accessed with the Documents
popup menu. The Documentspopup menu is found on the right side of the XPreview dialog and allows
the user to select from currently loaded documents. 

The Documents popup menu

Multiple documents may be loaded into XPreview using the same two methods used to open a
single document. Either select Preview Document from the File menu and select additional documents
to be previewed or drag one or more documents onto the XPreview application�s icon in the finder.
XPreview adds each newly loaded document to the Documentspopup menu.

To view the document information for any document currently included in the Documentspopup
menu, click on the menu and drag the mouse to the desired menu item before releasing the mouse but-
ton. 

Removing an Item from the Documents Popup Menu

XPreview allows the user to remove the currently selected item from the Documents popup
menu. To remove the currently displayed document, choose the Remove Document item from the File
menu. The currently selected document disappears from the Documentspopup menu. If the document
removed from the list is the only item, the entire XPreview dialog closes.

Printing XPreview Information

In addition to allowing the user to save XPreview information to a text file, the application also
lets the user print out the same information. To print the XPreview information for all documents cur-
rently listed in the Document popup menu, select Print� from the File menu. Set the print options, then
click the Print button. 
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The document which is output contains the same information XPreview saves to a text file:
Each document�s data is listed separately in the order the documents appear in the Documentspopup
menu. For a sample of how the printout will appear, see the next section, Saving XPreview Information
to a Text File.

Saving XPreview Information to a Text File

The XPreview information for all currently loaded documents may be saved to a text file for later
reference. To save the data, select Save from the File menu or press command-S. A dialog appears,
prompting the user to enter a name for the text file and the location the file should be saved.

The Save XPreview Text File dialog

When the name has been entered for the file, click the Save button to save the text file to the
indicated folder. The XPreview information is saved for all of the documents which currently appear in
the Documents popup menu. Each documents information is listed separately, and the documents are
listed in the order they appear in the Documentspopup menu. An example of an XPreview data text file
follows:
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Picture Previews

XPreview can use picture previews which are applied to documents several ways. The pre-
views which XPreview can interpret include:

� Page previews created using the Preview Editor Lite Create Thumbnails preference or using
the Preview Editor Create Thumbnails for Each Page feature. This creates page previews of
each page of the XPress document.

� Previews created by the Preview Editor XTension�s Append Preview preference while the
Create Thumbnails for Each Page feature is turned off. This creates a preview of one select-
ed page of the document.

� A page preview created using the Include Preview option found on the Save As dialog in
QuarkXPress version 3.2. This creates a preview of the first page of the document.

If one of these methods is not used to create a page preview for the page currently being dis-

Document: Conference Brochure v2
Pages in Document: 11
Document Size: 8.5� X 11�
Colors

Black
Window
PANTONE 355 CV
PANTONE 287 CV

Fonts
Helvetica
Palatino
Zapf Dingbats
Times
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Document: Conference Guidebook v4
Pages in Document: 28
Document Size: 8.5� X 11�
Colors

Black
PANTONE 224 CV
PANTONE 280 CV

Fonts
Times
Optima
Zapf Dingbats
Present

Graphics
Barbara�s HD:FETC Icons:ship
Barbara�s HD:FETC Icons:shell
Barbara�s HD:FETC Icons:shuttle icon
Barbara�s HD:FETC Icons:bird
Barbara�s HD:FETC Icons:flamingo
Barbara�s HD:FETC Icons:palm
Barbara�s HD:FETC Icons:sun
Barbara�s HD:FETC Icons:earth

�����
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played in the XPreview dialog, the page thumbnail display area displays a message to indicate that no
preview is available.

The �No Preview Available� message

XPreview Notes:

� XPreview will only display previews for XPress documents that contain picture previews. The
picture previews can be created by either Preview Editor or by checking the Include Preview
check box in the QuarkXPress 3.2 Save File As dialog.       
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Preview Editor Lite
Preview Editor Lite adds information to the document�s resource fork so that XPreview can dis-

play the document�s pages and vital information about the document such as colors, fonts and import-
ed graphics used in the document. The Preview Editor Lite XTension works in the background, adding
data to documents whenever the files are opened or saved. 

The Preview Editor Lite preferences dialog allows the user to set the attributes of previews
which are automatically added to each document created or saved while Preview Editor is loaded in
QuarkXPress. To activate the Preview Editor preferences dialog, select Preview Editor� from the
Preferences hierarchical menu found under the Edit menu. 

The Preview Editor Lite Preferences dialog

The settings of the controls on the Preview Editor Lite preferences dialog affect each document
which is opened or created with XPress while the XTension is loaded, so make sure the preferences
are set as desired. The controls found on the dialog include:

Resolve Outdated Previews check box � If this box is checked, Preview editor updates a document�s
preview information if it is outdated whenever the document is closed, even when the document
is not saved. This helps ensure that a document which was altered on a computer which did not
have Preview Editor installed has its PICT preview kept current.

Create Finder Icon check box � If this box is checked, Preview Editor Lite adds an icon to the XPress
document so that when it is viewed in Finder, the icon displays a miniature of the document�s first
page.

Add XPreview Information check box � Checking this box causes Preview Editor Lite to add XPreview
data to the resource fork of the document which includes the colors and fonts used in the docu-
ment as well as the imported pictures in the document. 

Create Thumbnails check box � This check box causes Preview Editor Lite to create a thumbnail-size
preview for each page of the document. XPreview allows the user to display these thumbnails
one at a time in the XPreview dialog.
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Thumbnail Width and Length fields � These fields allow the user to define the size of the thumbnails
created by Preview Editor Lite. The thumbnail size is defined by the width and height of the
thumbnail in units of pixels.

XPreview Notes:

� Preview Editor Lite stores its information using the �pnot� resource. The �pnot� resource is
standard for document preview information proposed by Apple Computer. The �pnot� data
may be edited or created using resource editing applications such as ResEdit. The �pnot�
resource format is available from Apple Computer.

� The Create Thumbnails option set in the Preview Editor Lite Preferences dialog can signifi-
cantly add to the time it takes to save a document. It is recommended the Create Thumbnails
For Each Page check box be left unchecked unless the user plans to use XPreview on the
documents being created or edited. Turning this option off saves both time and storage
space, since the thumbnails add to the size of the XPress document. It is not necessary to
check the Create Thumbnails for Each Page check box to generate a finder icon.
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